
     

将一种直流电压变换成另一种固定或可调直流电压的变换电路,称为直-直变换电路,
又称为DC/DC变换。直流变换电路分为直接直流变换电路和间接直流变换电路。直接直

流变换也称为直流斩波变换,其输入与输出之间不隔离。间接直流变换是在直接直流变换

的基础上增加交流环节,在交流环节实现输入与输出间的隔离。本章将利用全控型元件对

直流斩波变换、隔离型直流变换进行PSIM 建模与仿真,并在开环直流变换电路的基础上,
引入闭环反馈控制,对闭环直流斩波变换进行建模与仿真。

5.1 斩波变换电路仿真

直流斩波变换包括降压斩波电路、升压斩波电路、升降压斩波电路、Cuk斩波电路、

Sepic斩波电路和Zeta斩波电路等六种基本斩波电路。直流斩波控制常采用的方法有脉宽

调制PWM、脉冲频率调整PFM及混合控制三种方法,最常用的是PWM 控制。本节利用

PWM控制技术,对6种基本斩波电路进行建模与仿真,讲解其具体建模、仿真分析的步骤

和过程。

5.1.1 降压变换电路仿真

降压斩波变换又称为Buck变换,是将高于输出要求的直流电压变换到规定输出的直

流电压。降压斩波变换电路由直流电源E、全控型元件V、续流二极管D、储能电感L及负

载R构成,其电路拓扑如图5-1(a)所示。
图5-1(a)中的全控型元件V可由MOSFET、IGBT、GTR等全控型元件构成,对于小功

率降压变换器,常用功率 MOSFET全控型元件作为电路的开关元件。通过对开关V的控

制,在负载R上得到一个脉动的直流,其平均输出电压小于或等于电源电压E。为了在负载

R上得到恒定的直流,在负载端并联一个滤波电容C,以减小输出直流的纹波,
 

如图5-1(b)
所示。

1.
  

建立仿真电路模型

(1)
 

启动PSIM仿真软件,新建一个仿真电路设计文件。
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图5-1 降压式变换电路拓扑

(2)
 

根据图5-1所示电路拓扑,从PSIM 元件库(菜单“Elements”或者“View→Library
 

Browser”菜单项)中选取直流电源、P-MOSFET、电力二极管、电感、电阻、电容等元件,并放

置于电路设计图上。PWM 发生器采用方波电源(位于“Elements→Sources→Voltage→
Square”菜单项)产生所需占空比的PWM脉冲。由于方波信号电源“Square”输出的PWM
是弱电控制信号,不能直接驱动开关管,需要将其输出用“On-off

 

Controller”元件转换成功

率电 路 驱 动 信 号,开 关 控 制 器“On-off
 

Controller”位 于“Elements→Other→On-off
 

Controller”菜单项下。在放置元件时可调整好各元件的方向及位置,放置位置可参考图5-1
电路拓扑各元件的位置。在选取元件时,可优先从PSIM 底部的元件快捷工具栏选取相应

元件,以快速元件选取。
(3)

 

利用PSIM画线工具(菜单项“Edit→Place
 

Wire”或工具栏
 

“ ”
 

图标),按照图5-1
所示拓扑将电路元件连接起来组成仿真电路模型。在连接导线时,可以调整元件的位置、方
向等,以方便连线并使模型美观。

(4)
 

放置测量探头,测量需要观察的节点电压、电流等参数。本例仿真拟测量输入电

压、输出电压、输出电流、驱动PWM波形等参数,故需放置相应的电压、电流测量探头。为

给测量探头一个参考点,放置一个参考地于电源的负端,完成后的电路模型如图5-2所示。

图5-2 降压变换电路仿真模型
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2.
 

电路元件参数设置

根据仿真需求设置电路中各电路元件的参数,本例将直流电源 E设置为100V,

P-MOSFET、电力二极管采用默认参数设置(理想元件参数),电感L设置为50μH,电容C
设置为200μF,电阻R设置为10Ω。PWM发生器设置为频率50kHz、幅值1V、占空比0.5,
直流偏移、起始时刻、相位延迟设置为默认参数(默认为0)。输入电压测量探头命名为Vi、
输出电压探头命名为Vo、输出电流探头命名为Io、PWM波形测量探头命名为PWM。设置

完参数的电路仿真模型如图5-2所示。

3.
  

电路仿真

完成电路模型构建后,放置仿真控制元件并设置仿真控制参数。本例设置的仿真时间

为0.05s,仿真步长为1μs,其他参数采用默认值。设置完仿真控制参数后即可启动仿真。

4.
 

仿真结果分析

(1)
 

对不带和带滤波电容C两种情况分别进行仿真。在仿真结束后,PSIM 自动启动

Simview波形窗口,将测量的Vi、Vo、Io、PWM分别添加到波形窗口进行观察与分析,其仿

真波形如图5-3所示。

图5-3 降压式变换电路仿真波形
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根据降压斩波变换器原理,输出电压Vo=DVi(D为占空比)。在输入电压Vi一定的

情况下,通过调整占空比D的大小,可以改变输出电压Vo的大小。对于不带滤波电容C的

输出波形Vo,是一个连续的脉动直流。其输出平均值 Vo=D×E。示例仿真D=0.5,故

Vo=50V;
 

对于带滤波电容C的输出波形Vo,是一个连续的恒定直流,其值为50V,符合直

流降压斩波的理论计算值。
(2)

 

PWM 脉冲发生器可以选择开关门控模块 Gating
 

Block模型,若使用 Gating
 

Block,其模型及参数设置如图5-4所示。

图5-4 Gating
 

Block作为PWM发生器模型

在5-2模型中,单击将PWM、On-off
 

Control、GND(接地符号)选中,然后右击,在弹

出的右键快捷菜单中选择Disable,将方波PWM发生器支路禁用。禁用后的支路在

仿真时不会运行,相当于没有该支路。若要启用该支路,可以选中将要启用的支路,
右击,在弹出的右键快捷菜单中选择Enable即可。
选择“Elements→Switches

 

→Gating
 

Block”选项,放置Gating
 

Block元件模型,并按

照图5-4连接线路。

Gating
 

Block模型参数设为50kHz,一个周期切换点数为2,切换点位置用电角度表

示。Gating
 

Block模块在仿真起始时刻为低电平,即在0°位置为低电平。一个周期

的电角度宽度为360°,50%占空比表明一个周期内高电平与低电平各占50%,即高

低电平宽度均为180°。若在0°位置将电平切换一次,电平就从起始时刻的低电平变

成高电平;
 

随后在180°位置切换一次,电平从当前的高电平变成低电平,低电平持续

到本周期结束。即两个切换点“0.
 

180.”形式50%占空比的方波信号。注意Gating
 

Block模型输出的是功率驱动信号,可直接驱动开关元件。
图5-4的模型仿真波形与图5-3完全一样,此处不再给出仿真波形结果。

本例仅设置一个占空比进行仿真讲解,读者可修改不同占空比再次仿真,观察不同占空

比下降压斩波变换电路的输出电压波形,验证降压斩波电路的工作原理及特性。

5.1.2 升压变换电路仿真

升压斩波变换又称为Boost变换,是将低于输出要求的直流电压变换到规定输出的直

流电压。升压斩波变换电路由直流电源E、全控型元件V、续流二极管D、储能电感L、滤波

电容C及负载R构成,其电路拓扑如图5-5所示。
升压斩波电路构成元件与降压斩波电路元件相同,仅交换了开关管V、电感L、续流二
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图5-5 升压变换电路拓扑

极管D的位置,使其变成一个升压变换电路。

1.
  

建立仿真电路模型

(1)
 

启动PSIM仿真软件,新建一个仿真电路设计文件。
(2)

 

根据图5-5所示电路拓扑,从PSIM 元件库中选取直流电源、P-MOSFET、电力二

极管、电感、电阻、电容、方波信号电源“Square”、开关控制器“On-off
 

Controller”等元件,并
放置于电路设计图上。方波信号电源“Square”产生所需占空比的PWM 脉冲,开关控制器

“On-off
 

Controller”将PWM波转换成可驱动功率开关管的驱动信号。在放置元件时可调

整各元件的方向及位置,放置位置可参考图5-5电路拓扑各元件的位置。
(3)

 

利用PSIM画线工具按照图5-5所示拓扑将各元件连接起来组成仿真电路模型。
在连接导线时,可以调整元件的位置、方向等,以方便连线并使模型美观。

(4)
 

放置测量探头,测量需要观察的节点电压、电流等参数。本例仿真拟测量输入电

压、输出电压、输出电流、驱动PWM波形等参数,故需放置相应的电压、电流测量探头。为

给测量探头一个参考点,需放置参考地于电源的负端,完成后的电路模型如图5-6所示。

图5-6 升压变换电路仿真模型

2.
 

电路元件参数设置

根据仿真需求设置 电 路 中 各 电 路 元 件 的 参 数,本 例 将 直 流 电 源 E 设 置 为14V,

P-MOSFET、电力二极管采用默认参数设置(理想元件参数),电感L设置为50μH,电容C
设置为200μF,电阻R设置为10Ω。PWM发生器设置为频率50kHz、幅值1V、占空比0.3,
直流偏移、起始时刻、相位延迟设置为默认参数(默认为0)。输入电压测量探头命名为Vi、
输出电压探头命名为Vo、输出电流探头命名为Io、PWM波形测量探头命名为PWM,设置

完参数的电路仿真模型如图5-6所示。

3.
  

电路仿真

完成电路模型构建后,放置仿真控制元件,并设置仿真控制参数。本例设置的仿真时间

为0.05s,仿真步长为1μs,其他参数采用默认值。设置完仿真控制参数后即可启动仿真。
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4.
 

仿真结果分析

在仿真结束后,PSIM自动启动Simview波形窗口,将测量的 Vi、Vo分别添加到波形

观察窗口进行分析与查看,其仿真波形如图5-7所示。

图5-7 升压变换电路仿真波形

根据升压斩波变换原理,输出电压 Vo=
Vi
1-D

。仿真输入直流电压 Vi=14V,Vo=

20V,从仿真波形测量可知,在0.0235075s时,输出电压为19.9703V,符合理论计算结果。
读者可修改占空比,对不同占空比下的工作情况进行仿真,以验证升压变换电路的工作原理

及特性。

5.1.3 升/降压变换电路仿真

对于输入电压在输出电压值上下波动的情况,降压斩波变换和升压斩波变换不适用。
降压斩波变换和升压斩波变换只能对输入直流电压进行降压或者升压变换,仅适用于直流

输入电压恒定高于或者低于输出电压要求的情况。
对于在同一个变换电路中既需要升压、又需要降压的情况,可选择升/降压斩波变换器,

它可将低于输出要求的直流电压进行升压,又可以对高于输出要求的直流电压进行降压。
升/降压斩波变换器又称为Buck-Boost变换器,由直流电源E、全控型元件V、续流二极管

D、储能电感L、滤波电容C及负载R构成,其电路拓扑如图5-8所示。

图5-8 升/降压变换电路拓扑

升/降压斩波电路构成元件与降压斩波电路相同,仅交换了开关管V、电感L、续流二极

管D的位置,使其变成一个升/降压变换电路。注意:
 

升/降压变换器输出电压与电源电压

极性相反,属于反极性斩波变换器,负载上的电压极性为上负下正。

1.
  

建立仿真电路模型

(1)
 

启动PSIM仿真软件,新建一个仿真电路设计文件。
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(2)
 

根据图5-8所示电路拓扑,从PSIM 元件库中选取直流电源、P-MOSFET、电力二

极管、电感、电阻、电容、方波信号电源“Square”、开关控制器“On-off
 

Controller”等元件,并
放置于电路设计图上,放置位置可参考图5-8电路拓扑各元件的位置。

(3)
 

利用PSIM画线工具按照图5-8所示拓扑将电路元件连接起来组成仿真电路模型。
在连接导线时,可以调整元件的位置、方向等,以方便连线并使模型美观。

(4)
 

放置测量探头,测量需要观察的节点电压、电流等参数。本例仿真拟测量输入电

压、输出电压、输出电流、驱动PWM波形等参数,故需放置相应的电压、电流测量探头。为

给测量探头一个参考点,需放置一个参考地于电源的负端。完成后的电路模型如图5-9
所示。

图5-9 升/降压变换电路仿真模型

2.
 

电路元件参数设置

根据仿真需求设置电路中各电路元件的参数,本例将直流电源 E设置为15V,P-
MOSFET、电力二极管采用默认参数设置(理想元件参数),电感L设置为50μH,电容C设

置为200μF,电阻R设置为10Ω。PWM发生器设置为频率50kHz、幅值1V、占空比0.3,直
流偏移、起始时刻、相位延迟设置为默认参数(默认为0)。输入电压测量探头命名为Vi、输
出电压探头命名为Vo、输出电流探头命名为Io、PWM波形测量探头命名为PWM。设置完

参数的电路仿真模型如图5-9所示。
3.

  

电路仿真

完成电路模型构建后,放置仿真控制元件,并设置仿真控制参数。本例设置的仿真时间

为0.05s,仿真步长为1μs,其他参数采用默认值。设置完仿真控制参数后即可启动仿真。
4.

 

仿真结果分析

在仿真结束后,PSIM 自动启动Simview,将测量的Vi、Vo、Io、PWM 分别添加到波形

观察窗口进行分析,其仿真波形如图5-10所示。

根据升/降压斩波变换原理,输出电压Vo=
D
1-DVi

。当占空比D<0.5时,工作在降压

模式,当占空比D>0.5时,工作在升压模式。本例仿真模型输入直流电源 Vi=15V,当
D=0.3时仿真结果为Vo=-6.43V,当D=0.7时仿真结果为Vo=-34.94V,仿真波形

测量结果符合理论计算结果。

5.1.4 Cuk斩波变换电路仿真

Cuk斩波变换器与升/降压变换器一样,属于反极性升/降压变换器。Cuk斩波变换电
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路由直流电源E、全控型元件V、续流二极管D、储能电感L、滤波电容C及负载R构成,其
电路拓扑如图5-11所示。

图5-10 升/降压式变换电路仿真波形

图5-11 Cuk斩波变换电路拓扑

1.
  

建立仿真电路模型

(1)
 

启动PSIM仿真软件,新建一个仿真电路设计文件。
(2)

 

根据图5-11所示电路拓扑,从PSIM元件库中选取直流电源、P-MOSFET、电力二

极管、两个电感、电阻、电容、方波信号电源“Square”、开关控制器“On-off
 

Controller”等元

件,并放置于电路设计图上,放置位置可参考图5-11电路拓扑中各元件位置。
(3)

 

利用PSIM画线工具按照图5-11所示拓扑将电路元件连接起来组成仿真电路模

型。在连接导线时,可以调整元件的位置、方向等,以方便连线并使模型美观。
(4)

 

放置测量探头,测量需要观察的节点电压、电流等参数。本示例仿真拟测量输入电

压、输出电压、输出电流、驱动PWM波形等参数,故需放置相应的电压、电流测量探头。为

给测量探头一个参考点,需放置一个参考地于电源的负端。完成后的电路模型如图5-12
所示。

2.
 

电路元件参数设置

根据仿真需求设置 电 路 中 各 电 路 元 件 的 参 数,本 例 将 直 流 电 源 E 设 置 为20V,
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P-MOSFET、电力二极管采用默认参数设置(理想元件参数),电感L1、L2设置为100μH,
电容C1设置为500μF,C2设置为200μF,电阻R设置为10Ω。PWM 发生器设置为频率

50kHz、幅值1V、占空比0.3,直流偏移、起始时刻、相位延迟设置为默认参数(默认为0)。
输入电压测量探头命名为Vi、输出电压探头命名为Vo、输出电流探头命名为Io、PWM波形

测量探头命名为Vpwm,设置完参数的电路仿真模型如图5-12所示。

图5-12 Cuk变换电路仿真模型

3.
  

电路仿真

完成电路模型构建后,放置仿真控制元件,并设置仿真控制参数。本例设置的仿真时间

为0.04s,仿真步长为1μs,其他参数采用默认值。设置完仿真控制参数后即可启动仿真。

4.
 

仿真结果分析

在仿真结束后,PSIM自动启动Simview波形窗口,将测量的 Vi、Vo分别添加到波形

观察窗口进行分析,其仿真波形如图5-13所示。

图5-13 Cuk变换电路仿真波形

根据Cuk斩波变换原理,输出电压Vo=
D
1-DVi

,当占空比D<0.5时,工作在降压模

式;
 

当占空比 D>0.5时,工作在升压模式。本例仿真模型输入直流电源 Vi=20V,当
D=0.3时仿真结果为Vo=-8.57V,当D=0.7时仿真结果为Vo=-47.64V。仿真波形
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测量结果符合理论计算结果。

5.1.5 Sepic斩波变换电路仿真

升/降压变换器和Cuk斩波变换器属于反极性升/降压变换器,其输出电压极性与电源

极性相反,在某些场合不适用。为解决输出电压极性反相问题,学者提出了Sepic升/降压

斩波变换电路,该电路在PWM波占空比低于0.5时进行降压变换,占空比大于0.5时进行

升压变,同时Sepic变换电路输出电压极性与输入电源极性一致。Sepic变换电路依然由直

流电源E、全控型元件V、续流二极管D、储能电感L、滤波电容C及负载R构成,其电路拓

扑如图5-14所示。

图5-14 Sepic斩波变换电路拓扑

1.
  

建立仿真电路模型

(1)
 

启动PSIM仿真软件,新建一个仿真电路设计文件。
(2)

 

根据图5-14所示电路拓扑,从PSIM元件库中选取直流电源、P-MOSFET、电力二

极管、两个电感、电阻、两个电容、方波信号电源“Square”、开关控制器“On-off
 

Controller”等
元件,并放置于电路设计图上,放置位置可参考图5-14电路拓扑结构中各元件的位置。

(3)
 

利用PSIM画线工具按照图5-14所示拓扑将电路元件连接起来组成仿真电路模

型。在连接导线时,可以调整元件的位置、方向等,以方便连线并使模型美观。
(4)

 

放置测量探头,测量需要观察的节点电压、电流等参数。本例仿真拟测量输入电

压、输出电压等参数,故需放置相应的电压测量探头。为了给测量探头一个参考点,需放置

一个参考地于电源的负端。完成后的电路模型如图5-15所示。

图5-15 Sepic变换电路仿真模型

2.
 

电路元件参数设置

根据仿真需求设置 电 路 中 各 电 路 元 件 的 参 数,本 例 将 直 流 电 源 E 设 置 为20V,

P-MOSFET、电力二极管采用默认参数设置(理想元件参数),电感L1、L2设置为100μH,
电容C1、C2设置为200μF,电阻R设置为10Ω。PWM发生器设置为频率50kHz、幅值1V、
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占空比0.3,直流偏移、起始时刻、相位延迟设置为默认参数(默认为0)。输入电压测量探头

命名为Vi、输出电压探头命名为Vo,设置完参数的电路仿真模型如图5-15所示。

3.
  

电路仿真

完成电路模型构建后,放置仿真控制元件,并设置仿真控制参数。本例设置的仿真时间

为0.1s,仿真步长为1μs,其他参数采用默认值。设置完仿真控制参数后即可启动仿真。

4.
 

仿真结果分析

在仿真结束后,PSIM自动启动Simview波形分析窗口,将测量的 Vi、Vo分别添加到

波形窗口进行分析,其仿真波形如图5-16所示。

图5-16 Sepic变换电路仿真波形

根据Sepic斩波变换原理,输出电压Vo=
D
1-DVi

。本例仿真模型输入直流电源Vi=

20V,当D=0.3时仿真结果为Vo=8.56V,当D=0.7时仿真结果为Vo=47V。仿真波形

测量结果符合理论计算结果。

5.1.6 Zeta斩波变换电路仿真

Zeta斩波变换器与Sepic变换器一样,属于同极性升/降压变换器,由直流电源E、全控

型元件V、续流二极管D、储能电感L、滤波电容C及负载R构成,其电路拓扑如图5-17
所示。

图5-17 Zeta斩波变换电路拓扑
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1.
  

建立仿真电路模型

(1)
 

启动PSIM仿真软件,新建一个仿真电路设计文件。
(2)

 

根据图5-17所示电路拓扑,从PSIM元件库中选取直流电源、P-MOSFET、电力二

极管、两个电感、电阻、两个电容、方波信号电源“Square”、开关控制器“On-off
 

Controller”等
元件,并放置于电路设计图上,放置位置参考图5-17电路拓扑结构中各元件的位置。

(3)
 

利用PSIM画线工具按照图5-17所示拓扑将电路元件连接起来组成仿真电路模

型。在连接导线时,可以调整元件的位置、方向等,以方便连线并使模型美观。
(4)

 

放置测量探头,测量需要观察的节点电压、电流等参数。本例仿真拟测量输入电

压、输出电压等参数,故需放置相应的电压测量探头。为了给测量探头一个参考点,需放置

一个参考地于电源的负端。完成后的电路模型如图5-18所示。

图5-18 Zeta变换电路仿真模型

2.
 

电路元件参数设置

根据仿真需求设置 电 路 中 各 电 路 元 件 的 参 数,本 例 将 直 流 电 源 E 设 置 为20V,

P-MOSFET、电力二极管采用默认参数设置(理想元件参数),电感L1、L2设置为100μH,
电容C1设置为200μF,C2设置为200μF,电阻R设置为10Ω。PWM 发生器设置为频率

50kHz、幅值1V、占空比0.3,直流偏移、起始时刻、相位延迟设置为默认参数(默认为0)。
输入电压测量探头命名为Vi、输出电压探头命名为Vo,设置完参数的电路仿真模型如图5-18
所示。

3.
  

电路仿真

完成电路模型构建后,放置仿真控制元件,并设置仿真控制参数。本例设置的仿真时间

为0.1s,仿真步长为1μs,其他参数采用默认值。设置完仿真控制参数后即可启动仿真。

4.
 

仿真结果分析

在仿真结束后,PSIM自动启动Simview波形分析窗口,将测量的 Vi、Vo分别添加到

波形窗口进行分析,其仿真波形如图5-19所示。

根据Zeta斩波变换原理,输出电压 Vo=
D
1-DVi

。本例仿真模型输入直流电源 Vi=

20V,当D=0.3时仿真结果为Vo=8.57V,当D=0.7时仿真结果为Vo=46.65V,仿真波

形测量结果符合理论计算结果。
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图5-19 Zeta变换电路仿真波形

5.2 隔离型直流变换电路仿真

间接隔离型直流变换电路实现输入端与输出端之间的隔离,以满足某些应用中需要相

互隔离的输出要求。带隔离的直流-直流变换电路增加了交流环节,也称为直-交-直变换电

路,其电路结构如图5-20所示。

图5-20 带隔离型直流变换电路的结构

采用这种复杂电路结构可实现输出电压与输入电压的比例远小于1或大于1的直流变

换。为降低交流环节变压器、滤波器的体积和重量,交流环节一般采用高频变压器。由于工

作频率较高,逆变电路通常采用全控型元件,如GTR、MOSFET、IGBT等,整流电路中通常

采用快恢复二极管或通态压降较低的肖特基二极管。
带隔离型直流变换电路分为单端和双端两大类,单端电路中变压器流过的是脉动直流

电流,而在双端电路中变压器流过的是正负对称的交流电流。单端电路包括正激变换和反

激变换电路,双端电路包括半桥、全桥和推挽变换电路。

5.2.1 正激变换电路仿真

正激变换又称为Forward
 

Converter,有多种不同的电路拓扑结构,典型的单开关正激

变换电路拓扑如图5-21所示。
电路工作过程:

 

开关S闭合后,变压器绕组 W1两端的电压为上正下负,与其耦合的

W2绕组两端的电压也是上正下负(带点的是同名端),因此VD1处于通态,VD2为断态,电
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图5-21 正激变换电路拓扑

感L的电流逐渐增长;
 

开关S断开后,电感L
通过VD2续流,VD1关断。变压器的励磁电流

经 W3绕组和VD3流回电源。当输出滤波电感

电流连续时,输出电压理论值为Uo=
N2
N1
ton
TUi

,

其中N1、N2为 W1绕组与 W2绕组的匝数,ton
为开关S的导通时间,T为开关周期。

1.
  

建立仿真电路模型

(1)
 

启动PSIM仿真软件,新建一个仿真电路设计文件。
(2)

 

根据图5-21所示电路拓扑,从PSIM 元件库中选取直流电源、三绕组变压器、P-
MOSFET、三个电力二极管、电感、电阻、两个电容、方波信号电源“Square”、开关控制器

“On-off
 

Controller”等元件,并放置于电路设计图上,放置位置可参考图5-21电路拓扑结构

中各元件的位置。注意正激变换副边为一个绕组,因此将三绕组变压器的原边作为副边

W2,而变压器的两个副边绕组作为 W1和 W3。
(3)

 

利用PSIM画线工具按照图5-21所示拓扑将电路元件连接起来组成仿真电路模

型。在连接导线时,可以调整元件的位置、方向等,以方便连线并使模型美观。
(4)

 

放置测量探头,测量需要观察的节点电压、电流等参数。本例仿真拟测量输入电

压、输出电压、输出电流、驱动PWM波形等参数,故需放置相应的电压、电流测量探头。为

给测量探头一个参考点,需放置一个参考地于电源的负端。完成后的电路模型如图5-22
所示。

图5-22 正激变换电路模型

2.
 

电路元件参数设置

根据仿真需求设置电路中各电路元件的参数,本例将直流电源DC设置为50V,开关S、
电力二极管D1~D3采用默认参数设置(理想元件参数),三绕组变压器T3采用默认参数,
匝比为1∶1∶1。电感L1设置为10mH,电容C1、C2设置为200μF,电阻R设置为10Ω。

PWM发生器设置为频率50kHz、幅值1V、占空比0.3,直流偏移、起始时刻、相位延迟设置

为默认参数(默认为0)。输入电压测量探头命名为Ui、输出电压探头命名为Uo、输出电流

探头命名为Io、PWM波形测量探头命名为Upwm、电感电流探头为IL,设置完参数的电路

仿真模型如图5-22所示。
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3.
  

电路仿真

完成电路模型构建后,放置仿真控制元件,并设置仿真控制参数。本例设置的仿真时间

为0.02s,仿真步长为1μs,其他参数采用默认值。设置完仿真控制参数后即可启动仿真。

4.
 

仿真结果分析

在仿真结束后,自动启动Simview,将测量的Ui、Uo分别添加到波形观察窗口,其结果

波形如图5-23所示。

图5-23 正激变换仿真波形

从图5-23仿真输出波形可知,通过调整PWM的占空比D,可实现对输出电压的控制。
注意仿真输出电压与理论计算有偏差。读者可修改变压器T3和元件的参数,观察不同参

数下的仿真效果,找到正激变换器的最优设置参数。

5.2.2 反激变换电路仿真

反激变换又称为Flyback
 

Converter,典型的反激变换电路拓扑如图5-24所示。反激变

图5-24 反激变换电路拓扑

换电路中的变压器起储能作用,可以看作是一对相互耦

合的电感。
电路工作过程:

 

开关S闭合后,VD1处于断态,W1
绕组的电流线性增长,电感储能增加;

 

开关S断开后,

W1绕组的电流被切断,变压器中的磁场能量通过 W2
绕组和VD1向输出端释放。当输出电流连续时,输出

电压理论值为Uo=
N2
N1
ton
toffUi

,其中N1、N2为 W1绕组

与 W2绕组的匝数,ton为开关S的导通时间,toff为开关S的关断时间。
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1.
  

建立仿真电路模型

(1)
 

启动PSIM仿真软件,新建一个仿真电路设计文件。
(2)

 

根据图5-24所示电路拓扑,从PSIM元件库中选取直流电源、双绕组变压器(极性

反相)、P-MOSFET、电力二极管、电阻、两个电容、方波信号电源“Square”、开关控制器“On-
off

 

Controller”等元件,并放置于电路设计图上,放置位置可参考图5-24电路拓扑结构的

位置。
(3)

 

利用PSIM画线工具按照图5-24所示拓扑将电路元件连接起来组成仿真电路模

型。在连接导线时,可以调整元件的位置、方向等,以方便连线并使模型美观。
(4)

 

放置测量探头,测量需要观察的节点电压、电流等参数。本例仿真拟测量输入电

压、输出电压、输出电流等参数,故需放置相应的电压、电流测量探头。为给测量探头一个参

考点,需放置一个参考地于电源的负端。完成后的电路模型如图5-25所示。

图5-25 反激变换电路模型

2.
 

电路元件参数设置

根据仿真需求设置电路中各电路元件的参数,本例将直流电源DC设置为50V,电力

MOSFET开关S、电力二极管D采用默认参数设置(理想元件参数),双绕组变压器T1采

用默认参数(不能使用理想双绕组变压器),匝比为1∶1。电容C1、C2设置为200μF,电阻

R设置为10Ω。PWM发生器设置为频率50kHz、幅值1V、占空比0.3,直流偏移、起始时

刻、相位延迟设置为默认参数(默认为0)。输入电压测量探头命名为Ui、输出电压探头命名

为Uo、输出电流探头命名为Io。设置完参数的电路仿真模型如图5-25所示。

3.
  

电路仿真

完成电路模型构建后,放置仿真控制元件,并设置仿真控制参数。本例设置的仿真时间

为0.4s,仿真步长为1μs,其他参数采用默认值。设置完仿真控制参数后即可启动仿真。

4.
 

仿真结果分析

在仿真结束后,PSIM 自动启动Simview波形窗口,将测量的 Ui、Uo分别添加到波形

观察窗口进行分析,其仿真波形如图5-26所示。
从图5-26仿真输出波形可知,通过调整PWM的占空比D,可实现对输出电压的控制。

读者可修改变压器T1及元件的参数,观察不同参数下的仿真效果,找到反激变换器的最优

设置参数。

5.2.3 半桥变换电路仿真

双端半桥变换电路具有两个互补的控制开关,典型电路拓扑如图5-27所示。半桥变换
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电路中,变压器一次侧的两端分别连接在电容C1、C2的中点和开关S1、S2的中点,电容

C1、C2的中点电压为Ui/2。S1、S2交替导通,使得变压器一次侧形成幅值为 Ui/2的交流

电压,改变开关的控制占空比,即可改变输出电压Uo的大小。

图5-26 反激变换仿真波形

图5-27 半桥变换电路拓扑

S1导通时,二极管VD1处于通态;
 

S2导通时,二极管VD2处于通态;
 

当两个开关都关

断时,变压器绕组 W1中的电流为零,根据磁动势平衡,W2、W3绕组中电流相等,方向相

反,VD1和VD2都处于通态,各分担一半的电流。S1或S2导通时电感L的电流逐渐上

升,两个开关都关断时,电感L的电流逐渐下降;
 

S1和S2断态时承受的峰值电压均为Ui。
为避免半桥中上下两开关同时导通,每个开关的占空比不能超过50%,应留有裕量。

当滤波电感输出电流连续时,输出电压理论值为Uo=
N2
N1
ton
TUi

,其中N1、N2为 W1绕

组与 W2/W3绕组的匝数,ton为开关的导通时间,T为开关周期。

1.
  

建立仿真电路模型

(1)
 

启动PSIM仿真软件,新建一个仿真电路设计文件。
(2)

 

根据图5-27所示电路拓扑,从PSIM元件库中选取直流电源、三绕组变压器、两个

P-MOSFET开关、两个电力二极管、三个电容、电感、电阻、方波信号电源“Square”、逻辑非

门、时间延迟单元、开关控制器“On-off
 

Controller”等元件,并放置于电路设计图上,放置位

置可参考图5-27电路拓扑结构的位置。
(3)

 

利用PSIM画线工具按照图5-27所示拓扑将电路元件连接起来组成仿真电路模

型。在连接导线时,可以调整元件的位置、方向等,以方便连线并使模型美观。
(4)

 

放置测量探头,测量需要观察的节点电压、电流等参数。本例仿真拟测量输入电

压、输出电压、输出电流等参数,故需放置相应的电压、电流测量探头。为给测量探头一个参

考点,需放置一个参考地于电源的负端。完成后的电路模型如图5-28所示。模型中PWM
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输出的脉冲一路通过非门NOT进行取反,再通过时间延迟单元TD(形成控制死区),形成

开关S2的驱动脉冲。S2与S1的脉冲互补,且S1、S2不同时导通。

图5-28 半桥变换电路模型

2.
 

电路元件参数设置

根据仿真需求设置电路中各电路元件的参数,本例将直流电源DC设置为50V,电力

MOSFET开关S1、S2、电力二极管D1、D2采用默认参数设置(理想元件参数),三绕组变压

器T3采用默认参数,匝比为1∶1∶1。电容C1、C2、C3设置为200μF,电感L设置为

10mH,电阻R设置为10Ω。PWM发生器设置为频率50kHz、幅值1V、占空比0.3,直流偏

移、起始时刻、相位延迟设置为默认参数(默认为0)。时间延迟单元TD延迟时间设置为

1μs。输入电压测量探头命名为 Ui、输出电压探头命名为 Uo、S1的驱动脉冲探头设置为

Pwm_s1、S2的驱动脉冲探头设置为Pwm_s2,设置完参数的电路仿真模型如图5-28所示。

3.
  

电路仿真

完成电路模型构建后,放置仿真控制元件,并设置仿真控制参数。本例设置的仿真时间

为0.2s,仿真步长为0.4μs,其他参数采用默认值。设置完仿真控制参数后即可启动仿真。

4.
 

仿真结果分析

在仿真结束后,PSIM 自动启动Simview波形窗口,将测量的 Ui、Uo分别添加到波形

观察窗口进行分析,其仿真波形如图5-29所示。
从图5-29仿真输出波形可知,通过调整PWM的占空比D,可实现对输出电压的控制。读

者可修改变压器T3及元件的参数,观察不同参数下的仿真效果,找到半桥变换器的最优参数。

5.2.4 全桥变换电路仿真

双端全桥变换电路具有两对互补控制的开关桥臂,典型电路拓扑如图5-30所示。全桥

变换电路中逆变电路由4个开关组成,互为对角的两个开关同时导通,同一侧半桥上下两开

关交替导通,将直流电压逆变成幅值为Ui的交流电压,加载到变压器的一次侧。通过改变

占空比就可以改变压器二次侧VD1~VD4整流输出电压ud 的平均值大小,即改变输出电

压Uo的大小。
当S1与S4开通后,VD1和VD4处于通态,电感L的电流逐渐上升;

 

当S2与S3开通

后,VD2和VD3处于通态,电感L的电流也上升;
 

当4个开关都关断时,4个二极管都处于
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图5-29 半桥变换仿真波形

图5-30 全桥变换电路拓扑

通态,各分担一半的电感电流,电感L的电流逐渐下降。S1和S2断态时承受的峰值电压均

为Ui。为避免同一侧半桥中上下两开关同时导通,每个开关的占空比不能超过50%,还应

留有裕量。当滤波电感输出电流连续时,输出电压理论值为 Uo=
N2
N1
2ton
T Ui,其中N1、N2

为 W1绕组与 W2绕组的匝数,ton为开关的导通时间,T为开关周期。
1.

  

建立仿真电路模型

(1)
 

启动PSIM仿真软件,新建一个仿真电路设计文件。
(2)

 

根据图5-30所示电路拓扑,从PSIM元件库中选取直流电源、双绕组变压器、四个

P-MOSFET开关、四个电力二极管、电容、电感、电阻、方波信号电源“Square”、逻辑非门、时
间延迟单元、开关控制器“On-off

 

Controller”等元件,并放置于电路设计图上,放置位置可参

考图5-30电路拓扑结构的位置。
(3)

 

利用PSIM画线工具按照图5-30所示拓扑将电路元件连接起来组成仿真电路模

型。在连接导线时,可以调整元件的位置、方向等,以方便连线并使模型美观。
(4)

 

放置测量探头,测量需要观察的节点电压、电流等参数。本例拟测量输入电压、输
出电压、输出电流等参数,故需放置相应的电压、电流测量探头。为给测量探头一个参考点,
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需放置一个参考地于电源的负端。完成后的电路模型如图5-31所示。模型中PWM输出的

脉冲一路通过非门NOT进行取反,然后通过时间延迟单元TD,形成开关S2、S3的驱动脉冲。

图5-31 全桥变换电路模型

2.
 

电路元件参数设置

根据仿真需求设置电路中各电路元件的参数,本例将直流电源DC设置为50V,电力

MOSFET开关S1~S4、电力二极管D1~D2采用默认参数设置(理想元件参数),双绕组变

压器T1采用默认参数,匝比为1∶1。电容C设置为200μF,电感L设置为10mH,电阻R
设置为10Ω。PWM发生器设置为频率50kHz、幅值1V、占空比0.4,直流偏移、起始时刻、
相位延迟设置为默认参数(默认为0)。时间延迟单元TD延迟时间设置为2μs。输入电压

测量探头命名为Ui、输出电压探头命名为Uo、驱动脉冲探头设置为Pwm,设置完参数的电

路仿真模型如图5-31所示。

3.
  

电路仿真

完成电路模型构建后,放置仿真控制元件,并设置仿真控制参数。本例设置的仿真时间

为0.1s,仿真步长为2μs,其他参数采用默认值。设置完仿真控制参数后即可启动仿真。

4.
 

仿真结果分析

在仿真结束后,PSIM 自动启动Simview波形分析窗口,将测量的 Ui、Uo分别添加到

波形观察窗口进行分析,其仿真波形如图5-32所示。

图5-32 全桥变换仿真波形

从图5-32仿真输出波形可知,通过调整PWM的占空比D,可实现对输出电压的控制。读

者可修改变压器T1及元件的参数,观察不同参数下的仿真效果,找到全桥变换器的最优参数。
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5.2.5 推挽变换电路仿真

推挽变换电路的电路拓扑如图5-33所示。推挽电路中两个开关S1和S2交替导通,在

图5-33 推挽变换电路拓扑

绕组N1和N1'两端分别形成相位相反的交流电

压,同时二次侧交流经全波整流得到期望直流。

S1导通时,二极管VD1处于通态,电感L的

电流逐渐上升;
 

S2导通时,二极管 VD2处于通

态,电感L电流也逐渐上升。当两个开关都关断

时,VD1和VD2都处于通态,各分担一半的电流。

S1和S2断态时承受的峰值电压均为2倍Ui。如

果S1和S2同时导通,就相当于变压器一次侧绕

组短路,因此应避免两个开关同时导通,每个开关各自的占空比不能超过50%,还要留有死

区。当滤波电感输出电流连续时,输出电压理论值为 Uo=
N2
N1
2ton
T Ui,其中N1、N2为一次

绕组与二次绕组的匝数,ton为开关的导通时间,T为开关周期。

1.
  

建立仿真电路模型

(1)
 

启动PSIM仿真软件,新建一个仿真电路设计文件。
(2)

 

根据图5-33所示电路拓扑,从PSIM元件库中选取直流电源、四绕组变压器、两个

IGBT开关、两个电力二极管、电容、电感、电阻、方波信号电源“Square”、逻辑非门、开关控

制器“On-off
 

Controller”等元件,并放置于电路设计图上,放置位置可参考图5-33电路拓扑

结构的位置。
(3)

 

利用PSIM画线工具按照图5-33所示拓扑将电路元件连接起来组成仿真电路模

型。在连接导线时,可以调整元件的位置、方向等,以方便连线并使模型美观。
(4)

 

放置测量探头测量需要观察的节点电压、电流。本例拟测量输出电压,故需放置相

应的电压测量探头。完成后的电路模型如图5-34所示。

图5-34 全桥变换电路模型

2.
 

电路元件参数设置

根据仿真需求设置电路中各电路元件的参数,本例将直流电源E设置为300V,电力

IGBT开关S1~S2、电力二极管D1~D2采用默认参数设置(理想元件参数),四绕组变压器

T4匝比为5∶1,其他参数采用默认参数。电容C设置为50μF,电感L设置为0.5mH,电
阻R设置为5Ω。PWM发生器设置为频率50kHz、幅值1V、占空比0.3,直流偏移、起始时
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刻、相位延迟设置为默认参数(默认为0)。输出电压探头命名为Vo,设置完参数的电路仿

真模型如图5-34所示。

3.
  

电路仿真

完成电路模型构建后,放置仿真控制元件,并设置仿真控制参数。本例设置的仿真时间

为0.1s,仿真步长为2μs,其他参数采用默认值。设置完仿真控制参数后即可启动仿真。

4.
 

仿真结果分析

(1)
 

在仿真结束后,PSIM自动启动Simview波形分析窗口,将测量的 Uo添加到波形

观察窗口进行分析,其仿真波形如图5-35所示。

图5-35 推挽变换仿真波形

从图5-35仿真输出波形可知,通过调整PWM的占空比D,可实现对输出电压的控制。读

者可修改变压器T4及元件的参数,观察不同参数下的仿真效果,找到全桥变换器的最优参数。
(2)

 

PWM信号发生器可以由相关逻辑元件与三角载波比较构成,如图5-36(a)所示。

图5-36 PWM信号模型
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控制电压Vm和VDC2相加或相减,获得幅值分别为3.5V与1.5V两个调制信号,随
后分别接入比较器CMP1的反相端和CMP2的同相端;

 

将幅值为5V、频率为10kHz、占空

比为0.5的三角波VTRI1分别接入比较器CMP1的同相端和CMP2的反相端。经CPM1、

CPM2比较后,分别获得占空比为30%的PWM信号S1和S2,该信号波形如图5-36(b)所示。
在仿真时需尽量将仿真时间步长设置为0.2μs或更小。

5.3 闭环直流变换电路仿真

在各种电子装置电源应用中或多或少地存在直流电源变换器,为保证直流输出电压值

恒定在负载需要的电压范围内,一般需要设置自动调整单元,以保证在输入电压或者负载发

生变化时,其输出电压能快速调整到规定的设定值。

图5-37 闭环直流变换反馈控制框图

在5.1节和5.2节的直流变换电路仿真中,
开关管驱动PWM脉冲的占空比被设置为某一固

定值。当输入电压或者负载发生变化时会导致

输出电压偏离设定的参考值,不具备自动调节能

力。为使输出直流电压稳定在某一允许的电压

值范围内,可以利用自动控制理论知识,根据当

前输出电压、电流值,构建闭环控制环路。在输

入或者输出电压发生波动时,自动调整PWM 的占空比,使输出快速稳定在允许电压范围

内。闭环直流变换电路功能框图如图5-37所示。
控制器实时采集当前输出直流值,与设定参考值比较获得控制误差量。控制器再利用

控制误差量通过某种控制运算,产生当前的控制量。脉冲发生器根据当前控制量,输出一定

占空比的PWM脉冲,实时调整功率变换电路,使其输出值稳定在设定的参考值。当输入直

流或者负载发生变化时,必然导致控制误差产生,控制器将立即动作,产生新的控制量去调

整变换电路,使其输出快速返回到设定值。

5.3.1 单环Buck变换电路仿真

根据图5-37所示的控制框图,利用PI控制作为控制器,构建的电压单环反馈控制

Buck变换器模型功能框图如图5-38所示。
图5-38中功率部分电路与5.1.1节的Buck斩波功率电路拓扑一致,反馈控制部分采

用输出电压反馈控制。变换器当前输出电压Vo与设定输出值Vref相减,得到当前控制误

差量Verr,误差量Verr经PI控制器运算处理后得到控制量Vc1,Vc1经上下限限幅后得当前

的控制量Vc,Vc在与锯齿波Sw比较得到当前的PWM脉冲。当Buck变换器输入或者负载

发生变化时,会导致当前输出电压Vo发生变化,反馈控制环路将自动产生新的控制量Vc,经
与锯齿波Sw比较后,获得新占空比的PWM脉冲,从而调整功率电路快速恢复到设置输出值。

本节拟采用电压单环反馈控制,设计一个输入为15V~20V,输出为5V的非隔离Buck
变换直流电压电源。根据图5-38所示的控制框图,构建的电压单环反馈Buck变换电路模

型如图5-39所示。
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图5-38 电压反馈控制Buck变换器模型框图

图5-39 电压反馈控制Buck变换器电路模型

图5-39(a)功率电路部分添加了电感电流传感器ISEN、输出电压传感器VSEN,传感器

增益设置为1,同时将开关管V的控制端口与端子PWM连接,电流传感器ISEN输出与端

子IL连接、电压传感器VSEN输出与端子Vo连接。端子元件在“Edit→Place
 

Label”菜单

项下,或单击工具栏“ ”图标放置。“Label”元件是电气连接标签,相同名字的电气标签将

自动连接在一起,不需要用实际电线连接起来。直流输入电源由 Vin和 VSTEP1串联构

成,在0.03s时VSTEP1从0V阶跃到5V,模拟输入电压从15V阶跃突变到20V的情况。负

载R2通过双向电子开关与R1并联,双向开关的控制端由阶跃信号VSTEP2控制,在0.06s
时产生一个0到1的阶跃,使开关在0.06s闭合,形成R1与R2并联,模拟负载变化情形。

图5-39(b)为反馈控制环路,设定的期望输出Vref为5V,PI控制器比例系数为1.2、积
分系数为0.0002,限幅器限幅范围为(0,1),锯齿波VIRTI1利用三角波信号发生器产生,
其频率为100kHz、幅值为1V、占空比为1,其余参数默认为0。
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设置仿真时间为0.1s、仿真步长为1μs进行仿真,仿真后PSIM 自动运行Simview波

形分析窗口,将Vi、Vo、Io添加到波形窗口进行分析,仿真波形如图5-40所示。

图5-40 输出电压电流波形

从图5-40可知,在0.03s时输入电压从15V阶跃到20V,输出仍然保持在5V不变。
在0.06s时负载R1和R2并联,使得输出电流Io增大,但输出电压Vo仍然保持恒定。稳

态性能与设置的控制参数有关,读者可以调整控制参数,或者采用其他控制策略,寻找最优

控制效果及控制方法。

5.3.2 双环Buck变换电路仿真

在5.3.1节中,利用单环电压反馈进行闭环控制,当输入电压或负载发生变化时输出虽

然能快速稳定在参考设定值,但其响应速度及稳定性稍差。目前在Buck变换中,常用电感

电流及输出电压构建电压外环、电流内环的双闭环控制环路,构成的Buck变换双环控制功

能框图如图5-41(a)所示。针对图5-41(a)所示的Buck变换电路模型,可构建如图5-41(b)
所示的双环控制环路模型,其仿真波形如图5-41(c)所示。

图5-41(a)中,利用电感电流IL构建双环控制,将电压外环产生的控制量作为电流内环

的参考电流,当外部条件发生变化时,电感电流能快速反映外部的变化,使得变换器能快速

进行调整。稳态性能与设置的控制参数有关,读者可以调整控制参数或者采用其他控制测

试,寻找最优控制效果及控制方法。

5.3.3 单环Boost变换电路仿真

与Buck变换器类似,升压Boost变换电路也可以构建电压单环反馈控制的闭环Boost
变换器,根据图5-37所示的控制框图,利用PI控制作为控制器,构建的电压单环反馈控制

Boost变换模型功能框图如图5-42所示。
本节拟采用电压单环反馈控制,设计一个输入为10~15V,输出为24V的非隔离Boost

变换直流电压电源。根据图5-42所示的功能控制框图,构建的电压单环反馈Boost变换电

路模型如图5-43所示。
图5-43(a)功率电路部分的输入电源由Vin与VSTEP1串联形成,在0.1s时VSTEP1

从0V阶跃到5V,模拟输入电压在0.1s时从10V阶跃到15V的情形。负载R2通过双向
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图5-41 电压电流双环控制环路模型

图5-42 电压反馈控制Boost变换模型框图
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电子开关与R1并联,在0.2s时,电子开关闭合使R2与R1并联,降低负载阻值,模拟负载

变化情形。图5-43(b)采用PI控制器形成控制环路,控制器的比例系数为0.025,积分系数

为0.00042。设定参考输出值为24V,其他参数与Buck电压反馈环的参数设置一样。

图5-43 电压反馈控制Boost变换模型

设置仿真时间为0.3s,仿真步长为1μs进行仿真,仿真后PSIM 自动运行Simview波

形观测窗口,将Vi、Vo、Io添加到波形窗口进行显示,如图5-44所示。

图5-44 输出电压电流波形

从图5-44可知,在0.1s时输入电压从10V阶跃到15V,输出经过短暂的调整后,恢复

到24V输出。在0.2s时负载R1和R2并联,使得输出电流Io增大,输出电压Vo仍然保持

恒定。变换器稳态性能与设置的控制参数有关,读者可以调整控制参数,寻找最优控制

效果。
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5.3.4 双环Boost变换电路仿真

与Buck变换一样,Boost变换也可以采用电压、电流双环控制,电流内环采用电感电流

作为控制参量,外环采用输出电压作为参量。构建的双环控制模型如图5-45(a)所示,仿真

波形如图5-45(b)所示。

图5-45 双环控制Boost环路模型

利用电感电流IL构建双环控制,当外部条件发生变化时,电感电流能快速反应外部的

变化,使得变换器能快速进行调整。稳态性能与设置的控制参数有关,读者可以调整控制参

数或者采用其他控制测试,寻找最优控制效果及控制方法。

5.3.5 电压控制正激变换电路仿真

5.2.1节对隔离型正激变换器进行了开环建模与仿真,其开关管S的控制脉冲占空比

是设置的一个固定值,当输入电压发生变化时,在相同占空比下其输出值不能保持恒定。为

解决输入电压变化时输出保持恒定问题,需要构成闭环控制。根据图5-37的闭环反馈控制

框图,利用PI控制,构建的电压反馈PI控制正激变换电路模型如图5-46所示。
图5-46模型是在图5-22的基础上更改其控制环路得到的。模型中将输入改为DC和

VSTEP1串联,VSTEP1设在0.1s时从0V阶跃到30V,模拟输入电压在0.1s时从45V突

变到75V的情形。控制环路利用输出电压反馈Vo与设定参考输出Vref的误差量Ve进行

PI运行,PI运算输出经限幅LIM 得到控制量Vc,Vc与锯齿波SW 进行比较,得到新占空

比的控制脉冲,控制功率电路进行调整,使输出电压Vo稳定在设定的参考值Vref。图5-47
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是仿真的结果波形。
从图5-47可知,输入电压在0.1s时从45V阶跃到75V时,输出电压Uo在整个输出期

间基本稳定在设定的参考值10V,不受输入变化的影响,保证了输出电压恒定。

图5-46 电压反馈控制正激变换器模型

图5-47 电压反馈控制正激变换仿真波形

5.3.6 电压控制推挽变换电路仿真

5.2.5节对隔离型推挽变换进行了开环建模与仿真,其开关管S1、S2的控制脉冲占空

比设置为一个固定值,当输入电压发生变化时,在相同占空比下其输出值不能保持恒定。类

似正激变换,可以根据图5-37所示的闭环反馈控制功能框图,利用PI控制器,构建电压反

馈PI控制推挽变换电路模型,如图5-48所示。
图5-48中,输入电源由E和VSTEP1串联,阶跃电源VSTEP1在0.1s时从0V阶跃到

30V,模拟输入直流电源在0.1s时从300V阶跃到330V的情形。变换器的输出由电压传

感器VSEN进行采样,VSEN的增益设置为1/10,即采集电压值缩小为1/10。参考设置

Vref为5V,即设置变换器的输出电压恒定在50V(放大10倍)。缩小后的输出电压采样值

Vo与设置的参考输入Vref比较获得当前输出误差量,经过PI运行、上下限限幅器LIM1
(限幅器的上限为5,下限为0)限幅后获得控制量Vc。锯齿波VTRI1采用频率为100kHz、
幅值为5V、占空比为1的三角波信号源产生。当前控制量Vc与锯齿波Sw比较,获得当前

开关管S1、S2的驱动PWM脉冲,驱动功率电路进行调整。仿真波形如图5-49所示。
从图5-49的仿真波形可知,输入电压Vi在0.1s时发生阶跃变成330V,输出电压Vo
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在阶跃处发生微小波动,但很快恢复到稳定期望值。输出电压Vo在整个输出周期基本保

持恒定,实现输入变化时自动调节输出电压的闭环控制。

图5-48 电压反馈控制推挽变换器模型

图5-49 电压反馈控制推挽变换器仿真波形

5.3.7 峰值电流控制Buck变换电路仿真

1.
 

单环峰值电流控制

  对Buck降压变换电路,可以利用电感电流的峰值实现输出电流控制。峰值电流控制

直接控制输出侧电感电流的大小,进而间接地控制PWM脉冲宽度,实现输出调整控制。峰

值电流控制暂态闭环响应较快,对输入电压变化和输出负载变化的瞬态响应较快。根据峰

值电流控制原理及图5-37闭环反馈控制框图,构建的峰值电流控制Buck变换器仿真电路

模型如图5-50所示。模型中输入电源由Vin和VSTEP1串联构成,VSTEP1在0.03s时产

生0V到5V的阶跃,使得输入电压在0.03s时由24V阶跃到29V,模拟输入电压变化情形。
输出负载由双向电子开关SS控制的 R2与电阻 R1并联,电子开关由 VSTEP2控制。

VSTEP2在0.06s时产生一个阶跃信号,使电子开关SS闭合,实现R2与R1的并联,并联

后负载电阻减小,模拟负载变化情形。
图5-50控制环路中,参考电流Iref设置为5A,即控制电感电流峰值为5A。触发器SR

设置为边沿触发模式(触发标志设置为0),时钟VSQ1设置为100kHz、占空比为50%、幅值

为1V的方波。时钟VSQ1周期性的置位触发器SR的Q端,使Q端输出高电平。Q为高
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电平时开关V导通,电感电流IL增加。当电感电流IL小于Iref时,比较器输出为0,与门

AND输出为0,RS触发器Q端继续保持高电平,V继续导通,电感电流继续增加;
 

当电感

电流IL大于设置参考值Iref时,比较器输出为1,由于原Q端为高,所以与门AND输出从

0变为1,使触发器RS的Q端清零变为低电平,Q端变为低电平导致开关管V关断,从而

使电感电流开始下降;
 

在下一个时钟VSQ1的上升沿,再次将触发器RS的Q端置位,重新

驱动开关管V导通,再次使电感电流增加。这样周期性地运行,就可以将电感电流限制在

设置的参考值,模型仿真波形如图5-51所示。

图5-50 单环峰值电流控制Buck变换器仿真模型

图5-51 单环峰值电流控制Buck变换仿真波形

从图5-51可知,在0.03s时输入电压从24V阶跃到29V时,输出电压、电流基本恒定,
电感电流峰值控制在5A,输出电流Io此时小于5A;

 

在0.06s时负载R1与R2并联,负载

电阻减小,导致输出电流增大,但输出电流约为5A且恒定。由于电感电流峰值被限制在
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5A,故输出电压此时下降到约为5V(负载并联,负载总阻值为1Ω,输出电流被限制在5A,
理论输出电压Vo应为5V),以满足电感峰值电流设定参考值Iref的限制。

2.
  

双环峰值电流控制

上述单环峰值电流控制,仅限制了电感电流的峰值,未实现对输出电压的控制。在实际

应用中,多采用电压外环、电感峰值电流内环构成双环峰值电流控制。根据双环控制原理,
构建的双环峰值电流控制Buck变换电路模型如图5-52所示。

图5-52 双环峰值电流控制Buck变换仿真模型

图5-52模型做了如下设置处理:
 

⟡ 输入电源由Vin和VSTEP1串联,VSTEP1设在0.03s时产生0到5的阶跃,模拟

变换器输入电压在0.03s时从24V阶跃到29V的情形。

⟡ 负载电阻R2通过电子开关SS与R1并联。电子开关受 VSTEP2控制,VSTEP2
在0.06s时产生一个阶跃,控制SS闭合,实现负载并联。

⟡ 控制环路参考电压Vref设置为5V,变换器输出电压传感器采集增益设置为1/2.4,
当输出控制误差为0时,输出电压Vo=5×2.4=12V。

⟡ 在0.06s前,负载为4Ω,若输出电压为12V,此时电流为3A,电感电流未达到最大

限制值5A,此时将稳定输出电压在12V。

⟡ 在0.06s后,由于负载R1与R2并联,使得负载阻值为2Ω,此时若输出电压为12V,
则输出电流为6A,必然使电感峰值电流超过最大限制Iref(限幅器LIM1的最大值

为5)。此时电压外环不起作用,变换器受峰值电流内环控制,使电感电流峰值为

5A,输出的平均电流约为5A。输出电压不再恒定在12V,变成以电流限制为准的

恒定电压。

⟡ 读者可修改PI控制参数,寻找变换器的最优控制参数,以获得输出性能最优。
对5-52的仿真模型进行仿真,仿真结束后,PSIM自动弹出Simview波形窗口,将需观

察的波形添加到Simview波形窗口进行分析,仿真波形如图5-53所示。
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图5-53 双环峰值电流控制Buck变换仿真波形

从图5-53仿真输出波形可知,在0.03s时输入电压发生阶跃变化,由于此时输出电流

低于设置的电感电流限值5A,输出保持恒定在12V,电压外环控制起作用;
 

在0.06s时负

载发生变化,导致输出功率增大,电感电流超过限值5A,此时电流内环起作用,将电感电流

峰值限值在5A。并联负载总阻值为2Ω,限制电流为5A,则输出被限制在10V。从仿真输

出电压Vo波形可知,输出稳定在9.32V,符合理论计算。

5.3.8 V2 控制Buck变换电路仿真

与电压、电流控制方式相比,V2 控制具有更快的负载响应速度,在动态要求较高的应用

中得到关注和应用。根据V2 控制原理,构建的仿真电路模型如图5-54所示。

图5-54 V2 控制Buck变换电路仿真模型
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图5-54模型做了如下设置:
 

⟡ Vin与VSTEP1串联模拟输入电压变换情形。VSTEP1在0.03s时从0V阶跃到

6V,与Vin串联后,模拟输入电压在0.03s时从24V阶跃到30V,形成一个可变的

输入电压源。

⟡ 电阻R2通过电子开关SS与电阻 R1并联,模拟负载变化情形。在0.06s时,

VSTEP2产生一个阶跃,使电子开关SS闭合,导致R2与R1并联,并联后负载电阻

值减小,用此模拟负载变化情形。

⟡ 电压传感器VSEN的增益设置为1/2.4,由于参考电压Vref设置为5V,则期望的

输出电压Vo=2.4×Vref=12V。

⟡ 控制环路中SR触发器触发模式设置为电平触发(触发标志设置为0)。

⟡ 触发时钟VSQ1设置为50kHz、占空比为0.5、幅值为1的方波信号。
设置完成的各参数如图5-54所示,对建立的仿真模型进行仿真,仿真波形如图5-55

所示。

图5-55 V2 控制Buck变换电路仿真波形

从图5-55可知,当输入电压Vi从24V跳变到30V时,直流输出保持稳定。在负载变

化时,输出电流增大,输出电压仍然保持稳定。在整个调整过程中,反馈控制电压Vc始终

跟踪输出电压采样Vs。当输入或负载变化时,输出响应非常快,在输出的整个区域几乎没

有波动。仿真波形充分表明了V2 控制的快速响应特性。

5.3.9 谷值电流控制Buck变换电路仿真

采样的电感电流中包含了电流谷值点,可以利用电感的谷值电流进行反馈控制。谷值

电流控制适合于占空比较小的变换控制。根据谷值电流控制原理,构建的谷值电流控制

Buck变换器电路模型及仿真输出波形如图5-56所示。
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图5-56 谷值电流控制Buck变换仿真模型及仿真波形
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  ⟡ 在仿真模型中,输入电压由Vin和VSTEP1串联构成,模拟输入电压变化情形,以
验证控制环路的控制效果。

⟡ 变换电路的输出电压传感器VSEN增益设置为1/2.4,即缩小为1/2.4。

⟡ 输出参考设置电压Vref设置为5V,即期望变换器的输出电压为5V×2.4=12V。

⟡ 控制环路中SR触发器触发模式设置为电平触发(触发标志设置为0)。

⟡ 触发器SR时钟VSQ1设置为50kHz、占空比为0.5、幅值为1的方波信号。
图5-56(a)的控制环路类似5.3.7节图5-52的控制环路。图5-52内环采用电感电流峰

值控制。图5-56(a)采用电感电流谷值进行控制,控制波形如图5-56(c)所示。在调整控制

过程中,电感电流的谷值始终不低于控制指令电流Iref。
从图5-56(b)、(c)可以看出,当输入或负载变化时,电感电流能立即响应变化情况,控制

器根据电感电流变化,快速响应,产生新的控制占空比,实现对功率变化电路的调整,使输出

在全域范围内保持稳定。

5.3.10 电压跟随控制Buck变换电路仿真

在5.3.1节,利用PI控制策略搭建了电压反馈控制Buck变换电路模型。在该模型中

使用PSIM自带的PI元件模型实现PI控制。PSIM 元件库还带有一个简化的C程序块

“Simplified
 

C
 

Block”模型,可以利用该元件模型设计任意的C程序控制策略,实现Buck变

换控制。为演示“Simplified
 

C
 

Block”元件模型如何实现Buck变换控制,本节设计一个输入

电压为15~20V、输出电压为5V的电压跟随控制策略,假定输出电压误差控制在±0.1V。
电压跟随控制策略就是让输出电压跟随设定参考值。设输出设定值为Vref,变换器当

前输出电压为Vo,当前输出电压误差为Verr=Vref-Vo。
当Verr>0.1V时,表明输出电压Vo低于设定参考值Vref。根据Buck变换的原理

(Vo=D*Vin,D为占空比,Vin为输入电压),此时应增大开关管驱动PWM脉冲的

占空比D。
当Verr<-0.1V时,表明输出电压Vo高于设定参考值Vref。根据Buck变换的原

理,此时应减小开关管驱动PWM脉冲的占空比D。
当-0.1V<Verr<0.1V时,说明 Vo在允许的误差范围,应保持开关管驱动脉冲

PWM占空比D不变。
开关管控制所需的PWM脉冲由控制电压Vctrl与锯齿波比较获得。当Vctrl值大

于锯齿波幅值时为高电平,小于锯齿波幅值时为低电平。
设锯齿波的幅值为5V,控制电压Vctrl的最大幅值也为5V,最小值均为0。
在控制调整时,只要调整控制电压Vctrl的幅值,即可实现对占空比的调整。
为了达到控制精度,设每次调整控制电压 Vctrl的步长为0.1V,即在增、减占空比

时,增、减控制电压Vctrl的步长为0.1V。
根据上述跟随控制策略,设计的简化C程序元件模块具有三个输入端口(分别为x1,

x2,x3),一个输出端口(y1)。其中,x1为Vo输入端口,x2为Vref输入端口,x3是前一时

刻输出控制量的反馈输入端口,y1为当前控制量输出端口,设计的简化C程序块为:
 

  double
 

Verr=0 
Verr=x2-x1 



190  

if Verr 0 1 
   
  y1=x3+0 1 
  if y1 5 
   y1=x2 
 
else

 

if Verr -0 1 
 
  y1=x3-0 1 
  if y1 0 
  y1=0 
 

利用设计的简化C程序块,构建的电压跟随Buck变换器仿真电路模型如图5-57所示。

图5-57 简化C程序块构建的Buck变换模型

图5-57模型中SSCB1为设计的简化C程序块,VTRI1为幅值为5V、频率为100kHz、
占空比为1的锯齿波,Vref为参考设定输出值。模型的仿真波形如图5-58所示。

图5-58 电压跟随控制仿真波形
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从图5-58可知,当输入电压在0.03s时从15V突变到20V时,变换器的输出仍然保持

5V输出。在0.06s时负载突变时,变换器输出电压仍然恒定在5V。仿真输出波形表明,所
设计的电压跟随控制策略实现了输出的稳定控制,满足控制设计目标。

5.4 本章小结

本章首先对开环直流斩波变换电路进行PSIM 建模与仿真,讲解其具体的建模方法和

仿真步骤,以验证基本斩波变换电路的工作原理;
 

随后对隔离型开环直流变换电路进行

PSIM建模与仿真,讲解其具体的建模方法和仿真步骤,以验证其工作原理及特性;
 

最后在

开环仿真电路模型的基础上,引入反馈控制,对闭环反馈控制直流变换电路进行建模与仿

真,并对反馈控制环路进行设计与分析。


